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1 Logging into Oracle Applications 

Navigation 

 

 Open the link for the Oracle Instance 

icarerp.iasri.res.in 



Core Human Resource Management System (HRMS) – User Manual Version 20.0 
 

 

                                                             9 of 103                                 

   

Screenshots and 
Steps 

 Enter the Username and Password as provided (individual user name/password to be used). Password need to 
be changed on first time login. 

 On logging into the application, a new page consisting of the responsibilities assigned to the user and the active 
notifications for the user will open up.  

  

User Name 

Password 
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   
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Click here to enter 

Basic Details 



Core Human Resource Management System (HRMS) – User Manual Version 20.0 
 

 

                                                             13 of 103                                 

   

 

1.1 Basics of Oracle Screens 

Menus  

 

 
 
 
1. New: Use this icon to create a new invoice. Alternative navigation: File->New 
2. Find: Use this icon to invoke find (query) screen. The keyboard short cut is F11 key. 
3. Save: Use this icon to save the record. Alternative navigation: File->Save or press CTRL + S 
4. Clear Record: Use this icon to clear the current (selected) record. This however does not delete a record that has 

already been saved. Alternative navigation: Edit->Clear->Record 
5. Delete Record: Use this icon to delete the current (selected) record. Alternative navigation: Edit->Delete 
6. Attachment: Use this icon to attach text files or other files if required. 
 
 

Keyboard Shortcuts Important Keyboard shortcut 
 

Function/Purpose Keyboard Shortcut 

Enter into query mode F11 

Query with partial information Prefix or suffix with % 

Execute query CTRL + F11 

Close/Exit screen F4 

Invoke List of Values CTRL + L 

Insert duplicate field SHIFT +F5 

Insert duplicate record SHIFT +F6 

 

 To query the form: 
 

New Find Save Clear Record Delete Record 

Attachment 
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1. For query, first press F11. 
2. Give partial information on screen like partial employee name, and prefix or suffix with %. 
3. Execute the query by pressing CTRL and F11. 

 
List of Value (LOV) 

LOV facilitates the completion of a text entry field when there are numerous values that may be assigned. LOVs are a 
useful alternative to drop-down lists, particularly in cases where displaying a long list of selections in a drop-down list 
would require excessive scrolling.  

Search within LOV list 

1. Click on the LOV icon. 
2. The list of LOV is displayed. 
3. If short list then scroll and select the required value. Press OK. 
4. If the LOV list is long, then enter any partial/full value and suffix with the ‘%’ in the Find field. The ‘%’ as prefix and 

suffix is also used where the subsequent word(s) of the total value is used for query. 
5. Then click Find button. 
6. This displays a shortened list of values that will match the query submitted. 

 Select the value desired and click OK. The original text entry screen is populated. 
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1.2 Creating a New Employee 

Follow the  simple steps 
as below 

1. Click on the 
New button to create 
a new employee 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
This section will help us to know the steps to create a new employee. The steps will also tell you what details need to be put and 
where they need to be put 
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2. Fill in the 
details as required ( 
PAN detail is 
mandatory and 
system wont save 
unless you put this 
correctly) 
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Click on Create Employment to create employee and generate id 
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3. Choose Action 
as – Create 
Employment 

 
 
 
 
 
4. Click on Save  

Button  
 
 
 
 
 

 

Click on Save  after you have finished entering.  
NOTE : Do not forget to click on save otherwise all your entries would be lost 
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1.2.1  Searching for Existing Employee 

You can search for 
employees in this 
window by two 
methods 

1. You need to enter 
employee name. 
eg. Mr.  Prajenshu 
S or 
%Prajenshu% 

(% is a wildcard 
that replaces all 
characters) 

 

 

2.  You need to type 
in the employee 
number. 

 

 

 

This will allow you to view various details of the employee as well as change details as required. You can see the following 

a) Name, Age, Marital Status, PAN, Contact No., Email etc. 

b) Permanent Address, Correspondence, Home Town Address 

c) Personal Information - Religion, Passport Information etc. 

d) Educational Qualification Details 

e) Dependent and Nominee Details 

f) Medical Assessment History Details. 

g) Old Employee ID, Service Book No., Personal File No.  and much more 
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1.2.2 Back dated creation of Employees  

1. Follow the 
simple steps as below 

2. Click on the 
New button to create a 
new employee 

3. Click on Date 

Track button  on 
right corner of screen 

4. Fill in the date 
for which you want to 
create back dated 
employee. Eg. 4-APR-
2001 

5. Follow other 
steps as you created 
new employee in 1.1 
above 
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Note: The effective date on the top left corner of next form appears and from that day onwards it is to be input 
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1.2.3  Entering Employee Address 

1. Click on the 
Address button 

 
2. Choose the Date 
From which the 
Address is Active 
3. Choose the type 
of Address as  
a. 
Current/Correspon
dence Address 
b. Home Town 
Address 
c. Permanent 
Address 
4. Click on the 
Address Field  
5. Fill Address 
6. Click Save 

Button  

 
 
Type of Address can be 
a. Current/Correspondence Address 
b. Home Town Address 
c. Permanent Address 
Note:  You can fill three types of addresses for a person but only one out of them can be marked Primary(check the box) 
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Note: The fields marked yellow are mandatory and you cannot save data without filling them. 
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1.2.4  Entering Additional Personal Details 

Click on the box above 
the Leaves& Others 

 
 
and Enter Details as  
required  
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1.2.5 Entering Passport Information 

1) Search for the 
employee on Enter& 
Maintain 

2) Click on Personal 
Info 

 
3)  Choose 

Passport/Religion/Ca
ste Details and press 
OK 

4) Choose Passport 
Details and click on 
Details Box 

5) Type the Name and 
Number as required 
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1.2.6 Entering Religion/ Category/ Height/ Identification Mark 

1) Search for the 
employee on Enter& 
Maintain 

2) Click on 
Personal Info 

 
3)  Choose 
Passport/Religion/Ca
ste Details and press 
OK 

 
4) Choose 
Religion/Category 
Information and click 
on Details Box 

5) Type the Name 
and Number as 
required 
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1.2.7 Entering Medical Assessment Details 

1) Search for the 
employee on Enter& 
Maintain screen 

2) Click on Personal 
Info 

 
3)  Choose Medical 

Assessment Details 
and press OK 

4) Enter Date of 
Assessment 

5) Choose type of 
Assessment from the 
drop down menu, as 
applicable 

6) Choose Consultation 
Result from drop 
down  

7) Enter any other 
details in the 
Description section 
and press Save 

 

 
 



Core Human Resource Management System (HRMS) – User Manual Version 20.0 
 

 

                                                             35 of 103                                 

   

 
 



Core Human Resource Management System (HRMS) – User Manual Version 20.0 
 

 

                                                             36 of 103                                 

   

 
 



Core Human Resource Management System (HRMS) – User Manual Version 20.0 
 

 

                                                             37 of 103                                 

   

1.2.8    Entering Employee Phone Number 

Click on Personal Info 
Button 
 
Select Phone Number 
and press OK 
 
Enter Type as Home, 
Home Fax, Mobile, 
Other etc. 
 
Enter Phone Number. 
 
Enter Date From. 
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1.2.9   Enter Educational Qualifications 

1) Click On the 
Personal Info 
 
2) Click on Boards & 
University and select all 
universities/boards for 
which you want to input 
details 
 
3) Click on Save 
 
4) Press F4 
 
5) Click On the 
Personal Info 
 
6) Click on "Educational 
Qualifications" 
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1.2.10  Entering Employee Picture  

Click on the Picture 
button 

 
On the Enter& Maintain 
screen 
 
Click on Browse and 
select the appropriate 
picture file and click 
apply 
 

 

 
 
 

1.2.11 Entering Disability 

You need to search for 
the employee. Click on 
Personal Info -> 
Disability. 
 
In Category you need to 
provide type of disability 
like Blind, Autism, 
Locomotor Disability 
etc., Choose Status as 
Active 
 
Choose the appropriate 
Reason by selecting 
from List 
 
Mention the Degree of 
Disability. 
 
Click on Further 
Information 
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Choose Yes 
 
Post this only 
employee can benefit 
under Section 80U 
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1.3 Entering Service Details of an employee 

After entering employee 
basic details click on 
Service Details tab 

 
 
1)  Enter Organization 

name which is the 
Name of the Institute 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2)  Enter Office Details 

as HQ/Institute, 
Division, 
Discipline/Func.Grp 
and Section 

 
 
 
 
 
 
 

The service details of an employee like his designation, institute working for, pay band and grade pay details are stored here. Apart 
from this the service type/category of the employee is given here like Scientist, Technical, Administrative or Casual Labour with 
Temporary status. 
 

 
 
After entering Institute Name enter the Office Details 
 
 
Office Details Example 1 – Administrative Staff 
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Office Details Example 2 – Scientific Staff 
 

 
 
 
 
 
 
Office Details Example 3 – Technical Staff 
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3)  Enter Employee 

Category – Scientific, 
Administrative 
,Technical or Casual 
labour with 
Temporary Status 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
Choose Employee Category 
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4)  Enter Designation 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
5) Enter relevant Pay 

Band and Grade Pay 
 
 
 
 

 
 
Choose Designation as required 

 
 
Choose Pay Band and Grade Pay applicable to the designation you have chosen 
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6) Enter relevant Payroll 

information eg. IASRI 
Monthly payroll for 
IASRI employees 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
Note: - Payroll Information is updated automatically and you need not type anything 
 
Enter Location of Institute 
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7)  Enter Work Location 

as appropriate  
MI – Main Institute 
RS – Regional Station 
 
 
 
8)  Enter Status from the 

Option  
 
  

 
Note : The naming convention of Institute location is MI – Main Institute, RS – Regional Station. Eg. IARI Delhi will be IARI (MI), New 
Delhi whereas its Wellington regional station will be IARI (RS), Wellington 
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1.3.1 Entering Supervisor Details of an employee 

Enter Supervisor 
Information 
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1.3.2 Entering Probation Details of an employee 

Enter Probation and 
Notice period 
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1.3.3 Entering Statutory Details of an employee 

Click on Statutory Info 
tab and press Control + 
L 
 
1. GRE – It will be the 

institute name 
 
2. PF Organisation – 

ICAR GPF 
 
 
3. Professional Tax 

Organisation – ICAR 
PT Organisation 
<<State Name>> 

 
 
 
 

 

 
 
Note - Professional Tax Organisation – ICAR PT Organisation <<State Name>> where state name is the state where the 
employee’s place of work is. Eg. For IASRI employees it is Delhi (DL) 
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1.3.4 Adding Salary Elements 

Search for Employee on 
people Form 
 
Click on Service Details 
 
Click on Salary 
Components 
 

 
 
Refer Payroll Guide to learn how to add elements and input values 
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1.4 Editing Service Specification of an employee 

Two fields need to be 
updated  

 
This is one of the most important sections of the HRMS system. You can enter/edit service details of an employee from this screen. 
This screen is important to do transactions related to transfers, deputations, promotion, lien pay band or grade pay change, dies non, 
suspension and many others. This screen maps the service book into the system. 
 
 
Service Specification changes are done through two simple steps 
 
Change of Status 
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Change of ‘Service Change Reason’ 
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1.4.1 Employee Transfer 

Read the adjoining 
case to do this 
transaction 

 
Case: If any employee transferred from other institute to your institute then you have to transfer the same in ERP system also.  

1. Go to “XXXX Establishment & Personnel Section” Responsibility. Click on “Open employee service record” search 

the employee by name or by user id -> Click on Service Detail. Click on Payroll related -> select Pay method -> 

change the effective date to last day in institute -> end date the pay method 

2. Now go “ICAR Transfer” responsibility to transfer from one institute to another. Change the effective date to DOJ 

of employee in current institute.  

Go to Service Detail and update organization name, payroll, location and other relevant information and then save it. 
 
 
Case : Suppose an employee is to move from IASRI to IARI under following circumstances 

1. Last day of service at IASRI – 19 Aug 2013  - To be done by IASRI admin/personnel staff 
2. Joining Time for IARI – 20- Aug 2013 to 21 – Aug 2013 – To be done by IASRI admin/personnel Staff 
3. Regular employee of IARI – 22 Aug 2013 – To be done by IARI admin/personnel staff 

 
NOTE : All transactions to be done in Update Mode and not Correction Mode 
 
Step 1 -  To be done by IASRI admin/personnel staff 
 

1. Date Track to 19 Aug 2013 
2. Choose service change reason as Transfer on Own Request or Transfer on Public Interest as applicable 
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Step 2 – To be done by IASRI admin/personnel Staff 
 

1. Date Track to 20 August 2013 
2. Change Organisation to IARI 
3. Change Designation, Pay Band and Office Details as applicable.  
4. Change Payroll to IARI Monthly Payroll 
5. Change Location to IARI (MI), New Delhi 
6. Change Status to – Joining Time 
7. Change Service Change Reason to – Transfer Joining Time 
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Step 3 – To be done by IARI admin/personnel staff as on 22 Aug 2013 
 

1. Date Track to 22 Aug 2013 
2. Change Status to Regular 
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Thus the employee has been transferred to IARI 
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1.4.2  Opted for Lien  

On the People form, 
click on Service 
Details Tab. 
 
Click on the "Alter 
Effective Date" icon on 
the Toolbar and select 
the date from which 
the Employee's Lien is 
to be entered. 
 
On the "Service 
Details form", Navigate 
to the "Status" field 
and select the value 
"Opted for Lien" from 
the list of values. 
 
Select the "Update" 
option on the screen. 
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1.4.3   Return from  Lien 

Navigate to "Status" 
field and select the 
value "Active 
Assignment" from the 
list of values. 
 
Navigate to "Service 
Change Reason" tab 
on the Assignment 
Form and select the 
value- Return from 
Lien. 
 
Click on Save button 
on the toolbar. 
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1.4.4  Deputation outside ICAR 

On the People form, 
click on Assignment 
Tab. 
 
Click on the Alter 
Effective Date icon on 
the Toolbar and select 
the date from which 
the Employee's 
Deputation outside is 
to be entered. 
 
On the Assignment 
form, Navigate to the 
Status field and select 
the value Deputation 
Outside ICAR from the 
list of values. 
 
Select the Update 
option on the screen. 
 
Navigate to Service 
Change Reason tabon 
the Assignment Form 
and select the value - 
External Deputation 
and click on Save 
button on the toolbar. 
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1.4.5   Return from Deputation outside ICAR 

Click on the Alter 
Effective Date icon on 
the Toolbar and select 
the date on which the 
Employee returns. 
 
Navigate to Status 
field and select the 
value Regular from the 
list of values. 
 
Navigate to Service 
Change tab on the 
Assignment Form and 
select the value- 
Return from External 
Deputation. 
 
Click on Save button 
on the toolbar. 
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1.4.6 Suspension counted as Qualifying Service 

On the People form, 
click on Assignment 
Tab. 
 
Click on the Alter 
Effective Date icon on 
the Toolbar and select 
the date from which 
the Employee's 
Suspension is to be 
tracked. 
 
On the Assignment 
form Navigate to the 
Status field and select 
the value Suspension 
counted as Qualifying 
Service from the list of 
values. 
 
Select the Update 
option on the screen. 
 
Navigate to Service 
Change tab on the 
Assignment Form and 
select the value - 
Suspension counted 
as Qualifying Service 
and click on Save 
button on the toolbar. 
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1.4.7 Suspension counted as Qualifying service 

Click on the Alter 
Effective Date icon on 
the Toolbar and select 
the date on which the 
Employee will return. 
 
Navigate to Status 
field and select the 
value Active 
Assignment from the 
list of values. 
 
Navigate to Service 
Change Reason tab 
on the Assignment 
Form and select the 
value- Return from 
Suspension. 
 
Click on Save button 
on the toolbar. 
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1.4.8  Entering Government Quarter Details 

Enter Type of quarters. 
 
Enter application  Date 
and allotment date 
 
Enter Owned By 
 
Enter other relevant 
information. 
 
Any Other Relevant 
Information 
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1.4.9 Entering Program Details 

Enter Program Type 
from drop down 
 
Enter Level of 
Participation from drop 
down 
 
Enter Program Name 
 
Enter Venue 
 
Enter Start Date 
 
Enter End Date 
 
Enter Duration 
 
Enter Program 
Conducted by 
 
Enter Approver 
 
Enter Funding agency 
 
Enter Cost Incurred 
 
Enter Program Status 
from drop down 
 
Enter Any Other Info 
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1.4.10 Entering Tour Program Details 

Enter Type of Visit 
from drop down 
 
Enter Purpose of Visit 
from drop down 
 
Enter 
Organization/Institute 
Visited 
 
Enter City Visited 
 
Enter Report 
Submission Date 
 
Enter Trip Start Date 
 
Enter Trip End Date 
 
Enter Trip Duration 
 
Enter Any Other info 
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1.4.11  Entering Employee Achievements 

Enter Reference 
Number 
 
Enter Name of the 
Particulars 
 
Enter Date of the 
Application 
 
Enter Date 
Accreditation 
 
Enter Co-owners (if 
any) 
 
Enter Any Other 
Relevant Information 
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1.5  Retirement 

On the People form, 
click on “Personal Info” 
Button. 
 
Select "Retirement 
Details" 
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1.5.1 Retirement on Superannuation / Retirement on Medical Grounds /  Compulsory Retirement 

 
Click on Personal Info 
 
Click on Retirement 
Details 
 
Choose Leaving 
Reason as Voluntary 
Retirement or 
Resignation as 
applicable. 
 
Enter the Office Order 
Issue Date (O.O Issue 
Date), Superannuation 
Date and Actual 
Resignation Date 
 
Click on "Retire" 
button 
 
Click on Save button 
on the toolbar. 
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1.5.2  Voluntary Retirement / Resignation 

 
Click on Service 
Details  
Click on Probation & 
Notice Period and 
insert notice period 
details 
 
Press F4 
 
Click on Personal Info 
 
Click on Retirement 
Details 
 
Choose Leaving 
Reason as Voluntary 
Retirement or 
Resignation as 
applicable. 
 
Enter the Office Order 
Issue Date (O.O Issue 
Date), Superannuation 
Date and Actual 
Resignation Date 
 
Click on "Retire" 
button 
 
Click on Save button 
on the toolbar. 
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1.6 Leaves 

Click on Establishment 
& Personnel section-> 
Personal info -> leave 
details. 
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1.6.1 Applying Leave through Forms 

Enter Leave Type as 
Adoption Leave, 
Casual Leave, Child 
Care Leave, Earned 
Leave, Half Pay Leave 
etc. 
 
Enter Leave Reason 
from list of values 
accordingly. 
 
Enter Projected Start 
Date and End Date. 
 
Enter Actual Start 
Date and Actual End 
Date. 
 
Duration would be 
calculated 
automatically. 
 
Click on Save. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 



Core Human Resource Management System (HRMS) – User Manual Version 20.0 
 

 

                                                             78 of 103                                 

   

 
In case you need to 
mention more details 
about the leave please 
click on the small box 

 on the right 
down corner and the 
adjacent box will 
appear. 
 
Going Out of Station 
needs to be marked 
yes if person went 
away 
 
Details of Visit to 
include stopovers etc. 
 
Name of Family 
Members is relevant 
for LTC 
 
Block Year to be 
chosen appropriate to 
the year 
 
Prefix Dates & Suffix 
Dates to be chosen 
appropriately 
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1.7 Enter Dependent & Nominees Details 

On the People form, 
click on Personal Info 
Tab. 
 
Click on "Dependant 
and Nominee Details" 
 
Enter Details as 
required 
For minors please 
specify Guardian 
Details 
 
Press Save 
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1.7.1  Enter Dependent/Nominee Address & Phone 

Click on "New" icon on 
the toolbar. 
 
Enter the Last Name, 
First Name and Title 
as applicable. 
 
Enter the Birth 
Date,and  Gender. 
 
On the Contact 
Relationship section, 
enter the RElationship 
type and the date from 
which it is applicable. 
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Click on Contact 
Details 
 
 
Click on Enter Address 
 
Fill Address and click 
Save 
 
Click on Enter Phone 
Numbers 
 
Fill in Phone Numbers 
and Click Save 
 
 

 
 
Enter Address of Dependent/Nominee 
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Enter Phone Numbers as applicable 
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1.7.2 Enter Nomination Details 

 
Click Nomination 
Details button 
 
ON the Contact Extra 
Information form, click 
on the Details field. 
 
Select the Benefit 
Type as Medical 
Insurance, ESI, Family 
Pension, Provident 
Fund, Percentage 
shares as applicable. 
 
Each benefit type has 
to be listed out as 
applicable. 
 

In case employee has not specified Nominees through Self Service and the situation is such that Admin needs to specify 
Nominee Details 
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Choose Benefit type and punch in details according to rules 
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1.8 Creating a Vacancy 

 

 
 
 
 
To input additional Details, click on the box next to Status column 
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Enter Additional Details as required 
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1.9 Creating an Applicant 

Click on people->Enter 
& Maintain. 
 
Choose Applicant 
Press New 
 
New Form would 
open. 
 
Enter Last Name, First 
Name. 
 
Enter Gender. 
 
Enter Date of Birth. 
 
Enter PAN Number 
(Mandatory) 
 
Click on Action and 
Select Create 
Applicant. 
 
Click on Save. 
 

 
 
Choose Empanelled Applicant 
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Press Save 
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1.9.1 Mapping Applicant to Vacancy 

Search for Applicant 
on People Screen 
 
Click on Personal Info 
Button 
 
Choose Vacancy 
Application 

 
 
 
Click on Vacancy and select the Vacancy Requisition just created 
 



Core Human Resource Management System (HRMS) – User Manual Version 20.0 
 

 

                                                             91 of 103                                 

   

 
 
The details will be automatically filled directly from the vacancy details you had filled earlier 
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1.9.2  Hiring the Applicant 

Click on People-> 
Enter& Maintain. 
 
Find that Applicant for 
which you want to 
change Action. 
 
Change the date to 
future date from which 
he/ she was created 
as Applicant. 
 
 
Click on Personal Info 
 
Click on Vacancy 
Application 
 
Change Status to 
Accepted 
 
Click on Action. 
 
Select Hire Applicant. 
 
Applicant would 
change in to 
employee. 
 
Click on Save. 
 

 
 
 

 
 
Choose Mode of Recruitment 
Click on Accepted and then click OK. Click on Save 
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Come to People Screen and choose Hire Applicant from Action 
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2 Reports 

2.1 Management Information System (MIS) Reports 

Click on  
View  -Requests  
 
Click on Submit a New 
Request 
 
Click OK 
 
Type Name of Report 
 
Provide Parameters 
 
Click on Submit 
 
Click on No 
 
 
 

 

S. No. Report Name Report Description Parameters 

1 

ICAR HR Scientific 
Sanctioned Strength 
Report 

Shows the Scientific 
Sanctioned Strength in an 
Institute 

 

2 

ICAR HR Scientific 
In Position Breakup 
Report - With 
Specially Abled 
Details 

Shows the Scientific In-
position Strength in an Institute 
with disability counts 

 

  
 

3 

ICAR HR Scientific 
In Position Breakup 
Report - Without 
Specially Abled 
Details 

Shows the Scientific In-
position Strength in an Institute 
without disability counts   
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4 

ICAR HR Non-
Scientific Sanctioned 
Strength Report 

Gives Sanctioned strength 
details for Non-Scientific staff 

 

5 

ICAR HR Non-
Scientific In Position 
Report - With 
Specially Abled 
Details 

Gives In position strength 
details for Non-Scientific staff 
with disability count 

 

  
 

6 

ICAR HR Non-
Scientific In Position 
Report - Without 
Specially Abled 
Details 

Gives In position strength 
details for Non-Scientific staff 
without disability count 

 

  
 

7 

ICAR HR Non-
Scientific Vacant 
Report 

Gives count of Non Scientific 
Vacant Positions 

 

8 
ICAR HR Scientific 
Vacant Report 

Gives details of Scientific 
Vacancies 
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9 

ICAR HR 
Superannuation 
Report 

Gives details of 
Superannuation 

 

10 

ICAR HR Religion / 
Gender based 
headcount Report-
Age wise 

Gives Religion/Gender count 
based on age 

11 

ICAR HR Religion / 
Gender based 
headcount Report- 
caste wise 

Gives Religion/Gender count 
based on caste 

 

12 

ICAR HR Religion / 
Gender based 
headcount Report- 
religion wise 

Gives Religion/Gender count 
based on religion 

 

  
 

13 
ICAR HR Promotion 
Eligilbility Report 

Gives details of people 
eleigible for promotion 
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15 

ICAR HR 
Employees 
Qualificaton Report 

Gives details of employee 
Qualificaions 

  

17 
ICAR HR due for 
probation completion 

Gives details of people whose 
probation is about to end 

 

  
 
 

 
 
18 

ICAR Employee 
Detail Report 

Give details of all HR related 
details of all employees for the 
specific insitute  

19 

ICAR HR leave 
Pending for 
Approval 

Lists where the leave of the 
respective employee is 
pending  

 

2.2 Employee Specific Reports 

Click on  
View  -Requests  
 
Click on Submit a New 
Request 

 

S. 
No. Report Name Report Description Parameters 
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Click OK 
 
Type Name of Report 
 
Provide Parameters 
 
Click on Submit 
 
Click on No 
 
 
 

1 
ICAR HR Qualifying 
Period of Service 

Gives the entire service details of 
an employee and calcualtes 
qualifying period of service 

 

2 
ICAR HR Employee 
Profile Report 

Gives a summary of employee's 
details during his service 

 

 
 

3 
ICAR HR Noc 
Passport Noc for Passport Application 

 

4 

ICAR HR Property 
Declaration 
Transaction Report 

Permission/Intimation of aquiring 
property 

 

 
 

5 

ICAR HR Annual 
Immovable Property 
Report Annual property returns  

6 
ICAR HR NOC for 
Higher Studies Noc for Higher Education  
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7 

 ICAR APAR 
Employee Rating 
Report APAR ratings report  

8 
ICAR HR Proof Office 
Order 

Office Order for Proof of 
Employment  

 

2.3 Office Orders 

Click on  
View  -Requests  
 
Click on Submit a New 
Request 
 
Click OK 
 
Type Name of Report 
 
Provide Parameters 
 
Click on Submit 
 
Click on No 
 
 
 

 

S. 
No. Report Name Report Description Parameters 

1 
ICAR HR New 
Joinee Report Details of New Joinees 

 

2 
ICAR HR Transfer 
Report Details of Transfers done 
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3 
ICAR HR Leave 
Report Details of Leaves taken 

 

 
 

4 

ICAR HR 
Probation Status 
Report Details of employees on Probation 

 

5 

ICAR HR Category 
Wise Offer 
Templates Generates offer letter 

 

 
 

6 
ICAR HR Seniority 
Report 

gives details of employees based 
on seniority 

 

 
 

7 

ICAR HR 
Discipline Wise 
Report 

gives discipline wise employee 
details  
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8 

ICAR HR 
Promotion Office 
Order Office Order confirming promotion 

 

9 
ICAR HR Pay 
Fixation Report Office Order confirming pay fixation 

 

10 

ICAR HR Relieving 
Office Order for 
Foreign Training Office Order giving relieving order 

11 

ICAR HR 
Confirmation 
Office Order 

Office Order iving confirmation to 
people on probation 

 

12 
ICAR HR Tenured 
Post Office Order Office Order for Tenured Posts 

 

 
 

13 
ICAR HR Transfer 
Order Office Order for Transfers  



Core Human Resource Management System (HRMS) – User Manual Version 20.0 
 

 

                                                             103 of 103                                 

   

14 

ICAR HR 
Superannuation 
Office Order Office Order for Superannuation  

15 

ICAR HR Office 
Order Home 
Change Office Order for Home Change 

 

16 
ICAR Leave Office 
Order Office Order for Leave 

 

 
 

18 
ICAR HR Vacancy 
Creation Report 

Generated after a vacancy is 
created and carries specifications 
of that vacancy 

 

 

 


